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SETUP

System Configuration
Macintosh  II family or Quadra family (accelerated II Ci or better preferred). 8-bit color display card, 
color monitor, hard disk with 5Mb disk space free, 8Mb RAM minimum (16 Mb RAM preferred)
Applications & Extensions
MacroModel v.1.0 and Scripts folder
QuickDraw (if used w/out System 7)
Files You Need
• "MacroModel Demo" file
System Configuration
• QuickDraw (if used w/out System 7)
MacroModel Configuration
• Set application memory to 10 Mb (if your system will allow it)
• MacroModel Demo file open
Goal
• To built a realistic product prototype based on the "Direction 2000" product concept
Process Steps

1.. .Introduction to MacroModel
2.. .Setting-up the Body Outline
3.. .Building the Screen
4.. .Building the Control Panel
5.. .Building the Trackball
6.. .Building the Product Body
7.. .Building the Antenna
8.. .Viewing the Model



1. Introduction to MacroModel
Starting MacroModel
• Double-click on "MacroModel Demo" file icon
application icon to launch MacroModel.

• Point to the Tool Pallet

• Point to the Work space

• Point to the Tool Pallet 

• Toggle on "Show Working Plane" from the 
Object Menu

• Toggle off "Show Working Plane" from the 
Object Menu

MacroModel is a spline-based CAD accurate 
modeling tool that allows users to create a 
wide variety of three dimensional models 
useful to multimedia developers, graphic 
artists, product designers, engineers and any 
other professional needing powerful 3D 
modeling.

MacroModel is designed to allow users 
comfortable with a wide variety of 2D 
illustration and CAD tools to move their ideas
into the third dimension.

When you design in MacroModel, you design 
in one window.  This window looks into a 3D 
world that has x,y & z axis'.

All of MacroModel's object's are built from 
simple or complex 2D shapes.  2D shapes are 
built from a wide variety of common tools 
that you are probably already used to using

To draw these objects we need to have a 
surface, like a piece of paper for example.  
MacroModel draws and manipulates all 2D 
and 3D objects on, across and relative to the 
"Working Plane"

The Working Plane is in itself an object that 
can be numerically or interactively 
manipulated and moved within the 
MacroModel world.



2. Build the Body Outline
Create some "Construction Geometry"
• Show Construction Object tool group from 
the Tool Pallet

     Construction 

Grid
• Select the Construction Grid from the 
Construction tool group
• Set the draw center/corner-toggle to corner

     Corner Toggle

• Draw a Construction Grid filling the 
workspace

Before we start to draw the body outline of 
the Direction 2000 prototype, lets lay out 
some "Construction Geometry" that we can 
use to measure and snap geometry to.  
Construction objects can come in a variety of 
types including Lines, Grids, Axis' and Points.

For our purposes we will use the 
Construction Grid

...and we will draw this object from the 
corner

Now we will lay out a grid across the work 
space draw on the current working plane.  
This grid has a 1/4" grid, which is 
MacroModel's default measurement.  The 
grid is changeable, which is a feature we will 
use later.

*Remember Construction Grids are NOT 
substitutes for the Working Plane, although 
you still can "snap" points to Construction 
Grids and draw along grids that are not 
aligned with the Working Plane.

Create some Build the body outline

    Rectangle

• Select the Rectangle tool and, starting a .5" 
in and down from the top left corner of the 
Construction Grid, draw a rectangle measuring W: 
3" x H: 2"

To build the body outline of the product we 
will start by using simple rectangle s to mass-
out the shape.

The first rectangle will represent the major 
portion of the product that houses the Screen
and Control Panel.



*Watch the scrolling numbers to measure

    Rectangle

• Select the rectangle tool and starting .25" 
below the right top corner of the first rectangle 
draw another measuring W: 1" x H: 1.5"

The second rectangle represents the minor 
portion of the product that houses the 
Trackball.

• Select Geometry Modifier tool group and 
select the Cut tool and cut the lines that the two 
objects share out (this needs to be done twice: once 

for each object).    

Cut
To do this click on each end of the line segment and 
then click the segment itself.  Repeat this operation 
to remove the second piece of geometry.

• Marquis select the two rectangles and select 
"Join" from the Object menu.

• Click on the line with the cursor.

To make this one continuous 2D object we 
must cut portions of these two separate 
rectangles out so that they can be 
subsequently joined together.  

To cut parts of a 2D object apart simply 
designate the segment by clicking on each 
side of the line segment that you want to 
remove.  Notice that the arrow turns into a 
crosshair when the cursor passes over a line 
or point.  That means that MacroModel is 
"snapping" to a piece of geometry.  After 
selecting the extent of the piece to be 
removed, click on the segment itself and it 
will be cut out.  Now do this again because, 
afterall, there are two pieces of geometry on 
top of each other.

To "Join" these two shapes, much like you 
would in Illustrator™, select the lines and use
the "Join" command.  



Now the two separate objects are one

• Select Geometry Modifier tool group and 
select the Fillet tool.

    Fillet

• Hold down the "Option" key and click on the 
Fillet tool again.
• Click on each line segment on either side of 
the top left corner.

• Continue this operation all the way around.  
Remember that the 3rd and 8th corners go "in" so 
the 3rd corner in skipped and the 4th corner is 
filleted inward.  Do likewise for the corner on the 
opposite side of the outline.

• Option-click the Arrow tool when finished to 
make that tool the default tool.

Now to add rounded corners to this shape we
will "fillet" the corners with the Fillet tool.  To
make our work go faster, we can make the 
Fillet tool the default tool by Option-clicking 
the tool.  Now the tool will not change back 
to the arrow tool after each operation.   
Notice how the tool defaults to .25", which 
we will not alter.  This value can, of course, 
be edited to any value that will work within 
the constraints of the geometry that you want
to modify.

Start at the top left corner and click on each 
side of the corner.  MacroModel is smart 
enough to fillet the corner in between the two
line segments you click.

Continue this operation for every corner on 
this outline, skipping the 3rd corner so that 
we can create a inward curve at this point.

Again we will need to join the geometry so 
simply repeat the same procedure.

• Marquis select the outline and select "Join" 
from the Object menu.

Look at the  outline from another angle

To look at the work from another angle we 
can interactively move our view around the 
MacroModel world.  By holding down special 
command keys we can move wherever we 
want to interactively



    Pan/Rotate/Zoom View

• Select the Hand tool and, while holding down
either the Option or Command key interactively 
move the view around

• Select "Home" from the View menu to return 
to the default view.

To continue our work simply return to the 
"Home" view



3. Building the Screen
Create the basic screen shape

    Square

• Get the Square tool and draw a square 
starting a 1/4" down and in from the top left corner 
of the outline draw a 1.5" square.  The tool bar will 
read  W: 1.5.

.....Fillet

• Select Geometry Modifier tool group and 
select the Fillet tool.
• Hold down the "Option" key and click on the 
Fillet tool again.
• Click on each line segment on either side of 
the top left corner.
• Continue this operation all the way around. 
so that all of the corners are rounded.

Now we will build the Direction 2000's view 
screen.  It will consist of the screen itself and
surrounded by a screen trim

Select the Square tool from the rectangle tool
group and, starting a 1/4" down and in from 
the top left corner of the outline draw a 1 
1/2" x 1 1/2" square.

To create rounded corners to match the rest 
of the object select the fillet tool and make it 
the default tool like before.

Now fillet all of the corners of this square and
join them together.

This will be the outline for the screen. 

• Option-click the Arrow tool when finished to 
make that tool the default tool.
• Marquis select the screen outline and select 
"Join" from the Object menu.

Create the screen We will be able to use this geometry for two 



• Select the screen outline and choose 
Duplicate from the Edit menu.  The new object will 
be placed to the right of the original.

• Hold down the "H" key and, while holding the
mouse down, grab the right side of the object and 
move it horizontally to the left until it snaps into 
position on top of the original outline.

.....Extrude

• Select the Extrude tool and type tab so that 
the default extrude value of 1.0 is highlighted.  Type 
in .025 and type Return to lock-in the value, then 
either double click or type Enter to create the 3D 
shape.

• Double click on the middle of the screen 
object to open it.
• Double click on the middle of the screen 
object. again to close it.
• Open the "Materials..." browser ...

...and select "Screen" from the material list.  Close 
the browser when finished.

separate objects: the screen and the trim, so 
lets duplicate this object.

To place it EXACTLY on top of the original, 
we can constrain motion in only certain 
directions using "modifier" keys.  Here we 
will use the "H" key to move the new outline 
horizontally to the left until it "snaps" exactly 
on top of the original geometry.

Now we will turn this outline into a 3D 
object, which will be the screen.  To do this 
select the Extrude tool and type in an exact 
value that we want to extrude to which 
is .025".  Double clicking or typing Enter will 
initiate the action and create our first 3D 
shape.

To access the objects geometry for editing we
simply double click on the object.  To close 
the access to the points double click again.

To Change the color of the objects we can 
open the Material Browser and apply a new 
color.  Since the object is already selected all 
we have to do is pick a new color.  In this 
case we have set-up a list of colors 
corresponding to this demo, so pick the 
material called "Screen".  Materials can have 
color, reflectance, specularity, roughness and 
even Three-D or RenderMan shaders 
attached.  The "Squiggle" at the top will 
update as you change the values in the 
Material Browser to give you visual feedback 
about what type of material you are editing.



Create the screen trim

     Oval

• Select the Oval tool from the Circle tool 
group and, above the Construction grid draw a 
horizontally oriented oval whose length does not 
exceed approximately 1/4"

    Sweep

• Select the Sweep tool and click on the oval, 
then click on the black outline of the screen.  The 
cursor will turn into a crosshair when the arrow 
passes over the geometry.  Double-click or type 
Enter to create the 3D shape

• Open the "Materials..." browser and select 
"Trim" from the material list.  Close the browser 
when finished

Linking Objects

    Lock Link

• Select the Lock Link tool from the Link tool 
group.
• With the Lock Link tool selected place the 
mouse in the center of the screen and hold down the
mouse button and drag the line out to the screen 
trim object. and release the mouse button.  Both 
objects will be highlighted meaning that they are 
linked together.

To create the screen trim object we will use 
the "Sweep" tool, which will extrude a shape 
along a path.  The path, in this case, is the 
screen outline, so we will need a shape to 
extrude along this path.  Lets create a small 
oval and draw it at the top of the screen.

To "sweep" this shape we will pick the Sweep
tool and click on the oval, which will be the 
cross-section, and the original screen 
geometry, which will be the path.  When 
these are selected double click or type Enter 
to create the 3D shape.

Once again the object took on the default 
color so open the Material Browser and 
select the "Trim" material from the material 
list.

To create a real-world relationship between 
two or more objects, we need to "Link" them 
together.  Linking is a very powerful feature 
that allows us to create dynamic working 
models that simulate many of the ways 
objects work together in the real world.  With
linking we can produce ball joints, hinges, 
locked links and a number of physical 
relationships.  In this case we will use a 
simple "Lock Link" to "bolt" or "glue" these 
object together.

It is logical that if you created this object for 
real the screen would be set into the trim so 
create a link that links the screen TO the 
trim.  Notice now that BOTH objects are 
selected, meaning now they are linked 
together.  

We will see more sophisticated examples of 
this later in this demo.



4. Building Control Panel

     Rectangle

• Get the Rectangle tool and, starting .25" to 
the right of the top right corner of the screen object,
draw a rectangle that measures W: .75" x H: 1.5"

     Extrude

• Select the Extrude tool and double-click or 
type Enter to create the 3D shape

• Open the "Materials..." browser and select 
"Control Panel" from the material list.  Close the 
browser when finished

To create the Control Panel, where the 
prototype's input devices will reside, we will 
use the extrude tool again.  We will not place 
any objects on this panel to represent these 
input devices, but instead render them onto 
this object later in Macromedia's Three-D, 
which is a professional-quality animation and 
rendering application.  If you do not have 
access to Three-D or any number of other 
renderers on the market, then you may wish 
to create 3D objects that show where and 
how the buttons will be placed

Start by drawing a rectangle that measures 
3/4" x 1 1/2".  Notice how the number scroll 
as you draw the object.  You could also type 
in these values just as easily.

To create a 3D object from this rectangle 
choose the Extrude tool and double click or 
type Enter.  This creates an extruded 
rectangle that is .025" in height, which is the 
height that we set for the Screen object.  We 
could have interactively created the object 
height or typed in a new value if we wanted it
to be any different.

Once again the object took on the default 
color so open the Material Browser and 
select the "Control Panel" material from the 
material list.



5. Building the Trackball
Create the base 2D geometry

Changing the Grid dimensions
• Select "Rulers..." from the Object Menu and 
change "Divisions" from 4 to 8 and close dialog

Using the Center Arc tool

    Center Toggle

• Set the draw center/corner-toggle to center

.....Circle

• Select the Circle tool from the Circle tool 
group
• Draw a circle, where the Radius equals .375" 
on the toolbar, placed in the horizontal center and 
5/8" to the left of the right side of the body outline

In this section we will build a working track 
ball device for the Direction 2000.  The track 
ball will consist of a ball and a trim ring to 
hold it in the Direction 2000.  Lets start by 
creating the base 2D geometry for both of 
these objects.  This methodology should be 
getting familiar by now, for it will a lot like 
how we created the screen, except we will be
using some different tools.

With the Construction Grid at it's current 
dimensions, we will not be able to place and 
create the properly sized objects, so lets 
change the grid dimensions.  Currently the 
grid is set at 1/4" divisions, so we will simply 
change the grid so that it is set at 1/8" 
divisions.  At this scale we will be able to 
create the exact geometry we need and 
position it properly.

The first thing we will do is draw a piece of 
geometry that will be the basis for the 
trackball's trim.  Use the circle tool to draw a
3/8" circle in the middle of the lower portion 
of the body outline.



     Center Arc

• Select the Center Arc tool from the Arc tool 
group
• Draw a 180˚ arc by clicking first on the 
circle's center, then click vertically to the top of the 
circle so that the Radius equals .375" on the toolbar 
and finally click vertically to the bottom so that the 
Angle equals .180˚ on the toolbar

Create the base 3D Trackball

• The arc should still be selected

     Lathe

• Select the Lathe tool and click, first, on the 
top end of the arc and, second, on the bottom end of 
the arc.  The lathe tool will automatically initiate the
creation of the object.

• Open the "Materials..." browser and select 
"Trackball" from the material list.  Close the browser
when finished

Next we will draw a piece of geometry that 
will become the trackball itself.  Using the 
Center Arc tool, we will draw a half circle in 
the same place as the ring.  Notice how the 
numbers on the toolbar are giving us 
accurate numeric feedback about the 
dimensions of this arc.

To create the actual 3D trackball, we will use 
a new 3D tool called the "Lathe" tool.  The 
Lathe tool will rotate a piece of geometry, to 
any specified angle, around a user-specified 
axis.  For example to make a sphere from this
arc, all we have to do is specify an axis that is
defined by the two open ends of this arc.  The
lathe tool will then rotate this arc 360˚, the 
default value, around this axis to create a 
sphere.

Once again the object took on the default 
color so open the Material Browser and 
select the "Trackball" material from the 
material list. 



Create the base 3D Trackball trim

    Oval

• Select the Oval tool from the Circle tool 
group and, above the Construction grid draw a 
vertically oriented oval whose height does not 
exceed approximately 1/4"

     Sweep

• Select the Sweep tool and click on the oval, 
then click on the black outline of the screen.  The 
cursor will turn into a crosshair when the arrow 
passes over the geometry.  Double-click or type 
Enter to create the 3D shape

• Open the "Materials..." browser and select 
"Trim" from the material list.  Close the browser 
when finished

Linking Objects

    Ball Link

• Select the Ball Link tool from the Link tool 
group.

To make the ring that holds the trackball, we 
will use the same process we used to create 
the trim for the  screen.

To create the trackball trim object we will use
the "Sweep" tool again.  The path, in this 
case, is the we drew at the beginning of this 
part of the demo.  The object that we sweep 
along this path will be another oval.  

Lets create a small oval, much like we did for 
the screen trim, and draw it at the top of the 
screen.

To "sweep" this shape we will pick the Sweep
tool and click on the oval, which will be the 
cross-section, and the circle that surrounds 
the new 3D trackball object, which will be the
path.  When these are selected double click 
or type Enter to create the 3D shape.

Once again the object took on the default 
color so open the Material Browser and 
select the "Trim" material from the material 
list.

Just as we did for the screen object, we will 
need to create a real-world relationship 
between the trackball and the trackball trim 
objects.  There fore we will need to "Link" 
them together.  In the first example we used 
a "Lock Link" to lock both the attitude and 
the position of the objects relative to each 
other, but in this example we will use a "Ball 
Link" instead.  A Ball Link will lock the 
position, but not the attitude.  This means 
that the trackball can rotate freely in the 
trim, just like it would if it were a real 
assembly.



• With the Ball Link tool selected place the 
mouse in the center of the trackball object and hold 
down the mouse button and drag the line out to the 
trackball trim object. and release the mouse button. 
Both objects will be highlighted meaning that they 
are linked together.

Look at the  work -in-progress from another 
angle

     Pan/Rotate/Zoom View

• Select the Hand tool and, while holding down
either the Command key interactively move the view
by pushing the depressed mouse from the bottom of 
the screen to the top so 45˚ view is created.

It is logical that if you created this object for 
real the trackball would be set into the trim 
so create a link that links the trackball TO 
the trim.  Notice now that BOTH objects are 
selected, meaning now they are linked 
together.  

To look at the work from another angle we 
can interactively move our view around the 
MacroModel world.  By holding down the 
Command key we can move interactively to 
another view looking down on the work we 
have done thus far.



Interactively manipulate linked objects

     Arrow

• The Arrow tool will be automatically selected 
because it is the default tool.  Place the Arrow over 
the center of the trackball object and click and hold 
down the mouse button, while, at the same time, 
holding down the Option key.  While BOTH buttons 
are being held down slowly move the mouse around 
the workspace to see the trackball object rotate.

To see how the trackball will actually work all
we have to do is click and hold on the 
trackball object and, while holding down 
either the Option or Command keys like for 
the views, move the mouse around the 
screen.  Notice how the trackball moves only 
it's orientation, just like a functioning 
trackball would actually work!



6. Building the Product Body

Managing the model

• Click on the Screen Trim object and shift-
select the Control Panel and Trackball Trim 
objects so that all  objects in the model are selected.
Since the Screen Trim and Trackball Trim objects 
are parent objects of the objects that they contain, 
the entire assemblies will be chosen.

Creating the body object

     Zoom

• Select the Zoom tool and draw a marquee 
around the 90˚ corner located closest to the lower 
edge of the screen.  The marquee should be roughly 
3x larger than the corner element that you are 
zooming in to.   The numeric zoom percentage, 
located in the toolbar, should read roughly 5.0.

To build the body of the product we will use 
the body outline that we constructed at the 
beginning of this demo.  First, though, lets 
manage our model.  this means that we will 
"hide" objects that we are finished working 
on so that we can work more efficiently and 
faster.

We will, therefore, hide the objects that we 
have created thus far; the Screen Assembly, 
the Control Panel and the Trackball 
Assembly.  To "hide" these objects shift select
all of the objects and initiate the "Hide 
Selected" command from the Object Menu.  
The objects haven't been deleted...only 
hidden from view.  This means that the 
redraw time will be significantly faster 
because we don't have redraw those objects 
everytime we change something in the 
model.

To create the Direction 2000's main body we 
will ultimately use the "Skin" tool to create it,
but before we can use this tool we will have 
to set-up the 2D geometry to create a 3D 
object.

Lets start by zooming into a part of the body 
outline.  With the zoom tool draw a marquee 
around the 90˚ corner located closest to the 
bottom of the screen



     Offset

• Select the Offset tool from the geometry 
modifier tool group.  Place the arrow on the lower 
edge of the body outline and click and drag down 
until the new line "snaps" to grid 1/8" outside the 
original object.

• Hold down the "N" key so that "Normal" is 
displayed in the toolbar and place the Arrow over 
the new outline so it turns into a cross-hair.  Click 
and push forward so that the new outline is roughly 
1/8" below the original.

Next to make this body have round edges we 
will need to create and parallel copy of this 
geometry and move it below the current 
outline.  To do this we will start by picking 
the Offset tool, which makes parallel copies 
of 2D geometry.  This is far more useful than 
a simple scale, because all lines are perfectly 
parallel around the 2D object.  Now use the 
tool to create a parallel copy of the body 
outline 1/8" larger than the original.

Next we will move this new piece of 
geometry down,  or in the negative z 
direction  from where it is currently placed.  
As stated in the beginning of the demo all 
drawing and manipulation is done on a 
working plane.  All work we have done thus 
far has been across this working plane, or 
along the x and y axis'.  To move an object 
perpendicular, or in the z axis, relative to the 
working plane, we can use a special 
constraint key to do this.  Like we moved the 
screen geometry horizontally by holding 
down the "H" key, here we will move in the z 
axis, or up and down, by holding down the 
"N" (normal) key.  So hold down the "N" key 
and place the Arrow over the new outline so 
it turns into a cross-hair and click and push 
forward so that the new outline is roughly 
1/8" below the original.



• Click on the Construction Grid to select it.
• Open the "Objects..." browser in the Objects 
menu.
• Type -.25 in the Z field of the Position dialog
section of the Object browser and type Return to 
lock-in the value.

• Close the Object browser when finished.

• Shift-select the two outline objects and 
duplicate by choosing Duplicate from the Edit menu.
The new geometry will be placed to the right of the 
originals.
• Hold down the 3 key and place the arrow 
over one of the two hard corners of the duplicated 
objects and click and drag that corner to the 
corresponding corner on the original outline.

     3D Mirror

• Select the 3D Mirror tool from the Mirror 
tool group and click on 3 points on the Construction 
Grid.  The duplicated outlines should mirror 
themselves on the opposite side of the Construction 
Grid.

Click 3 Points on the grid...

The next step in creating the body will 
involve duplicating these two objects and 
"mirroring" them over the construction grid.  
In the last step we moved the new outline 
interactively, but what if we wanted exact 
placement?  In this example we will move the
Construction Grid exactly 1/4" below where it
exists now so that we can mirror the 
duplicated geometry over it.  To do this, 
select the grid by clicking on it and then 
opening the Object Browser.  To numerically 
change the Grid's position simply type in -.25 
in the Z field of the Position dialog section of 
the browser and type Return.  See how the 
Grid has changed position.  It is now 1/4" 
below where it originally was.

The next step in creating the body geometry 
is to duplicate the two outlines and match 
them to the originals.  First shift-select the 
two outlines and duplicate them.  Now place 
the arrow on one of the two hard corners of 
the duplicated geometry and, while holding 
down the "3" key, place the duplicated corner
on the corresponding corner of the original 
outline.  See how the corner "snaps" to the 
original corner.  The "3" key stands for 3D 
snap, which allows us to snap all sorts of 
points, lines and surfaces to any other 
geometry in the MacroModel, regardless of 
the position and orientation of the Working 
Plane

The last step in setting up this geometry is to 
now "mirror" these duplicated outlines to the 
opposite side of the Construction Grid.  
MacroModel has both 2D and 3D mirror 
tools.  2D mirror tools are found in virtually 
every draw program and simply mirror a 
selected piece of geometry over a line, which 
is a 2D element.  Since MacroModel is a 3D 
program, the functionality of the tool has 
been expanded to allow you to mirror over a 
3D plane.  While a line is designated by 2 
points, then a 3D plane is subsequently 
designated by 3 points.  Picking 3 points on 
the Construction Grid will then mirror these 
objects to the other side.



...to mirror over a grid

     Pan/Rotate/Zoom View

• Select the Hand tool and, while holding down
the Control key press the mouse button and push 
the mouse up in the workspace.

     Skin

• Select the Skin tool and start by placing the 
arrow over the top-most outline and click to select it.
Continue selecting the other three outlines in the 
same manner in a top to bottom fashion.

Double-click or type Enter to create the 3D object.

Now to actually create the body object, we 
will skin all of these outlines.  First 
interactively zoom out from the view we are 
in currently to get a better view of the object 
body.

To create the body select the Skin tool.  The 
Skin tool does exactly what it's name implies,
it puts a "skin" over two or more pieces of 2D
geometry to create a 3D surface.  In this case
the four outlines will be skinned to create the
body of the Direction 2000.  Start by 
choosing the 2D geometry from top to 
bottom, starting with the original piece that 
was created at the beginning of the demo and
moving sequentially down to the bottom-most
2D outline.  When all of these elements have 
been selected double click or type Enter to 
create the 3D object.



• Double-click on the new object.

• Place the Arrow over an active control point 
and click and drag the point.  Let go of the mouse 
button when finished moving the point and the 
shape will redraw in it's altered form.

One of the most powerful feature 
MacroModel has to offer is the fact that even 
3D objects can be edited.  If we double click 
on this new object, we will see the original 
outlines that created it.  

By selecting on of these control points and 
moving it, we can edit the 3D shape.  



• Select Undo Last from the Edit menu

• Double-click on the new object to close 
points.

MacroModel also feature 5 levels of undo, so 
we can journal backwards a number of steps. 
With this we can undo the edit we just 
performed.  

To "close" the object, double click on it.



7. Building the Antenna

Setting-up the Work View

• Select Home from the View menu

     Pan/Rotate/Zoom View

• Select the Hand tool and click and drag the 
Hand tool from the center to the right side of the 
workspace, so that the body is positioned half off the
screen.

Change the Working Plane

     Working Plane 

• Select the Working Plane tool to.  Click on 3 
points in a counter-clockwise fashion on the 
Construction Grid.

The last element of the model we will build 
will be the  Direction 2000's extendible 
antenna.  

To create this we will set-up our workspace 
by first going back to the "Home" view and 
using the hand tool to pan the view so that 
the body of the Direction 2000 is on the right 
side of the  screen.  

The second procedure will be to place the 
Working Plane, currently placed on top of the
Product Body, so that it is aligned with 
Construction Grid.  The Working Plane tool 
will allow me to place the Working Plane on a
variety of points, lines or surfaces.  In this 
demonstration we will just use points.  Like 
the 3D Mirror tool needs 3 points to define a 
plane, so does the Working Plane.  By 
designating 3 points on the Construction 
Grid, we can align the Working Plane to that 
object.

The reason we moved the Working Plane was 
so that we could draw the antenna so that it 
lies in the center of the body.  Remember that
all objects are drawn and moved across the 
working plane.



Build the 2D Geometry

     Line 

• Select the Line tool and, while holding the 
"V" key down, draw a line starting at the top/left of 
the body and going horizontally left.  The tool bar 
will start scrolling and stop drawing the line when 
the value in the toolbar is approximately 3".

     Center Toggle

• Make sure that the draw center/corner-toggle
is set to center

.....Circle

• Select the circle tool from the circle tool 
group and draw a circle in the lower left hand part 
of the workspace that measures approximately .1".

To build the 2D geometry that makes up the 
antenna draw a horizontally constrained line 
that extends from the top left-hand corner of 
the Direction 2000's Body.  Since we will be 
using the Sweep tool to create this shape, we 
will need to create an object to sweep along 
this new line.  

With the Circle tool draw a circle that has an 
approximate radius of .1".  The toolbar will 
give you feedback as to the exact size of the 
circle.



Build the 3D Geometry

     Sweep

• Select the Sweep tool and click on the circle, 
then click on the line.  The cursor will turn into a 
crosshair when the arrow passes over the geometry. 
Double-click or type Enter to create the 3D shape

Linking Objects

     Lock Link

• Select the Lock Link tool from the Link tool 
group.

• With the Lock Link tool selected place the 
mouse in the center of the antenna object and hold 
down the mouse button and drag the line out to the 
product body. and release the mouse button.  Both 
objects will be highlighted meaning that they are 
linked together.

To create  the antenna we will use the sweep 
tool to simply sweep the circle along the line, 
which is the path.

Just as we did for the screen and the 
trackball objects, we will need to create a 
real-world relationship between the antenna 
and the product body.  There fore we will 
need to "Link" them together.  In the first 
example we used a "Lock Link" to lock both 
the attitude and the position of the objects 
relative to each other.  In this example we 
will use the Lock Link again, but this time we
will modify the link.

As for the screen assembly, lock linking will 
lock both the position and attitude of these 
two objects relative to each other.  In order 
for the antenna to travel linearly in and out of
the Product Body we will have to modify the 
link.  But first we have to modify the view.



Look at the  work -in-progress from another 
angle

• Select the Axonometric view found in the 
Orient list in the View menu.

     Pan/Rotate/Zoom View

• Select the Hand tool and place the hand in 
the center of the workspace and depress the mouse 
and drag the mouse until the objects are centered in
the workspace.

Changing the link

• Click on the antenna to select it.
• Open the "Objects..." browser in the Objects 
menu.

Using the pre-scripted "Axonometric" view 
we can shift to a view that allows us to see 
the top of the product body and antenna.  

We can then center the view with the Hand 
tool by panning the antenna to the center of 
the screen.

To change the link of the antenna, select the 
object and open the Objects browser box.  
You will notice that the position and attitude 
boxes are all checked.  To create a link that 
allows the antenna to move in only one 
direction, up and down relative to the 
product body, we need to unlock one of the 
position boxes.  

MacroModel has a feature called a "Virtual 
Trackball" that gives us a visual 
representation of the orientation of selected 
objects.  Notice that, for the selected 
antenna, the "X" face of the trackball lines-up
with the top of the antenna.  



• Deselect the "X" position lock by clicking on 
the checked box to the right of the X field in the 
Position field of the browser.

• Close the Object browser when finished
• To move the object, click the arrow on the 
antenna and drag to the right and left.

Finishing the model

• Untoggle Hide Objects from the Objects 
menu.

    Lock Link

• Select the Lock Link tool from the link tool 
group.
• Option-select the Lock Link tool so it will be 
the default tool and link the :
1. Screen Trim to the Product Body
2. Control Panel to the Product Body
1. Trackball Trim to the Product Body

If we unlock the "X" position, we therefore 
unlink that part of the lock link, which allows 
the antenna now to move freely in that one 
direction.

To finish the model we need to link the 
hidden elements of our model to the product 
body.  Deselecting Hide Objects brings all of 
the objects back into view.

Now lets finish the model by lock linking all 
of the elements to the product body.



     Arrow 

• Option-select the Arrow tool so it will be the 
default tool.
• Click in the workspace to deselect the 
objects.

The model is now finished and ready for 
presentation viewing!



8. Viewing the Model

Final viewing of the model

• Open the "Views..." browser in the View 
menu.
• From the list of saved views click on "Final 
View"
• Close the View browser when finished

Clearing the construction geometry

• Choose Clear Construction Objects from the 
Objects menu

The last element of developing the Direction 
2000 prototype is viewing the model.  
MacroModel has the ability to save any 
number of views.  In this demo file there is a 
saved view named "Final View".

Notice the View browser is very similar to the
Object browser.  The Virtual Trackball now 
tracks the orientation of the view, not the 
objects here.  Notice also that when we select
the Final View from the list of saved views 
that the, view has a colored background 
attached.

To finally present the prototype we will 
"clear" the construction geometry.

This is the final presentation view of the 
Direction 2000 prototype in 
MacroModel!   Now on to Macromedia's 
Three-D for animation and photorealistic
rendering!

CONCLUSION
You have seen how MacroModel can take an idea and turn it into reality.  MacroModel has allowed us to 
create a CAD accurate, curved-surface model of the Direction 2000 long before we would have to create a
physical prototype of the product.  Furthermore, this model can be used by project engineers to actually 
create that physical prototype, used in conjunction with a CAD program like AutoCAD™,  and graphic 
artists can use the same model to create photorealistic images and animations to sell the idea, used in 
conjunction with an animation and rendering program like Three-D.
MacroModel's flexibility means that you can even go back and change that model just as easily.
Without a doubt, MacroModel is the tool of choice for a wide variety of design professionals!


